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I. Introduction 
 

In current technological developments, parabolic antennas with all the equipment 

have become one of the hardware devices that can be classified into luxury items because 

the price is quite expensive image quality. This is what makes parabolic antennas widely 

used, apart from that the price is quite expensive to make parabolic antennas a symbol of 

prosperity for those who have them. Broadly speaking, the use of a satellite dish is to 

capture TV broadcasts from satellites in the form of downlink signals transmitted by 

satellites. The channel that is ready to be channeled through a satellite dish is a channel 

that already occupies the satellite transponders. 

So far, many of the downlink signal receivers emitted by satellites use standard 

satellite dishes sold in the market, so users have to buy them from sellers at quite 

expensive prices. And while tracking satellite or looking for satellite signals many 

residents use TV as a tool to see the satellite signals they get, therefore residents must 

bring TV when tracking the satellite. 

There are also many types of LNBs. Each LNB can only be used for a single 

frequency band such as S-Band, C-Band and Ku-Band, each frequency requires a different 

resonator. 

In an lnb there is what is called polarity, there is horizontal polarity and vertical 

polarity. Horizontal polarity requires 18 volts dc power from the receiver, and vertical 

polarity requires 13 volts dc power supply. If there is one polarity that is off, for example 

the lnb is to pick up the palapa satellite signal but the vertical polarity is off, then we 

cannot catch broadcasts such as Mnc, Matrix tv, Jtv and other channels that are in one 

polarity with vertical. In a satellite dish the function of the lnb is very important, if our lnb 
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is damaged we will not be able to get a signal from the satellite, which will be interpreted 

by the receiver and in the end we will not be able to watch the television broadcast on the 

parabola. 

In an lnb there is what is called polarity, there is horizontal polarity and vertical 

polarity. Horizontal polarity requires 18 volts dc power from the receiver, and vertical 

polarity requires 13 volts dc power supply. If there is one polarity that is off, for example 

the lnb is to pick up the palapa satellite signal but the vertical polarity is off, then we 

cannot catch broadcasts such as Mnc, Matrix tv, Jtv and other channels that are in one 

polarity with vertical. In a satellite dish the function of the lnb is very important, if our lnb 

is damaged we will not be able to get a signal from the satellite, which will be interpreted 

by the receiver and in the end we will not be able to watch the television broadcast on the 

parabola. 

Each LNB can only be used for a single frequency band, because the S, C and Ku 

bands each require a different resonator cavity. There are also types for linear and circular 

signals, differentiated by the placement of the internal dipole. The power supply for 

electronic switches is also of interest. Power is provided by the receiver and supplied via a 

coaxial cable. So the coax cable not only transmits the signal received from the antenna to 

the receiver, but also requires operating power from the receiver to the LNB (along with 

additional control signals). 

Switch Features When switching channels a transponder has one or two different 

polarizations (horizontal or vertical and circular left or right). So the receiver has to tell the 

LNB the polarization of the given signal, so that the appropriate dipole can be activated. 

The power supply voltage is as follows: 14 V activates vertical polarization, while 18 V 

activates horizontal polarization. Although DiSEqC has been developed as a powerful 

control tool with more than 256 commands, it is still not used to shift polarization. 

The universal LNB has a second switch mode for the extended Ku band. Since the 

satellite receiver frequency range is not wide enough, the frequency range has to be 

separated into two frequency ranges. Switching between these two ranges is controlled by 

the 22 kHz signal which the receiver also sends to the LNB when selecting a particular 

channel. This 22 kHz signal is also used for the carrier frequency for DiSEqC control 

commands in more complex system configurations. This DiSEqC command can control 

multiswitches and antenna motors. 

 

II. Research Methods 
 

Some of the research methods used by the author are as follows: 

1. Interview  

Interviewing is the process of obtaining information by conducting direct questions and 

answers with related parties. 

2. Literature review  

By studying the material that has been obtained related to the thesis topic through media 

such as books, articles, writings on internet sites, and other information media. 

3. Study of literature  

Literature study is a method carried out by utilizing available literature, such as utilizing 

internet facilities, namely by visiting websites that are related to the problems faced by 

the author. As well as collecting references to available books. 

4. Programming and Implementation 

Making applications is done with Java programming language, this system support 

application in the form of android studio. 
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5. Evaluation 

The evaluation stage is carried out to determine the errors found and collected for 

analysis as a basis for further application development. 

 

III. Discussion 
 

3.1 Types of LNB 

a. LNB S-Band 

This LNB captures satellite signals with an input frequency of 2,520 MHz to 2,670 

MHz and an output frequency of 950 MHz to 1,100 MHz with a local oscillator of 2,620 

MHz. With a low enough input frequency for a satellite signal, which is 2,520 - 2,670 

MHz, of course, the signal will not be affected by weather disturbances such as cloudy and 

rainy weather. However, with low frequencies, of course, there is also a risk of intervention 

from other frequencies. In Asia, there is only one satellite that uses this frequency, namely 

the SES 7 Satellite which is located at the 108° E position which is used for paid or 

subscription parabolic transmissions. 

 

b. Lnb C-Band 

This Lnb captures satellite signals with an input of 3,400 MHz to 4,200 MHz and an 

output of 950 MHz to 1,750 MHz with a Local Oscillator of 5,150 MHz. The input 

frequency of 3,400-4,200 MHz tends to be safer from other frequency interventions and is 

still quite resistant to cloudy and rainy weather disturbances. The satellite that transmits the 

c-band frequency is very widely used by FTA (Free To Air) tv stations or free tv or non-

paid TV, and there are several pay TVs that use this frequency. The downside of this 

frequency is that the size of the parabolas must be large. 

 

c. Ku-Band Lnb 

Ku-Band Lnb captures satellite signals with an input of 10,700 MHz to 12,750 MHz 

and an output of 950 MHz to 2,150 MHz with a double Local Oscillator, namely with a 

frequency of 9,750 MHz and 10,600 MHz. This Lnb has the highest frequency in its class. 

In addition, the frequency coverage is wide enough to accommodate many transponders. 

With high frequency, it is very effective against other frequency interventions, but is 

vulnerable to being disturbed by cloudy and rainy weather. Ku-Band frequencies are 

mostly used for pay tv and only a few are used for FTA tv. 

 

3.2 Digital Parabolic Receiver 

According to Cai Wardana (2017) Parabolic Receiver is a device used to receive 

parabolic signals which will later be applied to television without a satellite dish receiver it 

will not be possible to broadcast a television program, Parabolic receivers have various 

types and brands according to their respective advantages. 

In the 1990s, the use of receivers for satellite dishes that were originally analog based 

was starting to be replaced by digital receivers. Of course, the reception process for digital 

receivers is of a better quality than that of analog receivers. It's just that, the digital receiver 

in 1996 still had MPEG2 quality. However, along with the development of technology in 

the satellite dish, especially in the receiver technology used, in the 2000s digital receivers 

already supported MPEG4. Of course, the technology carried by the MPEG4 receiver is 

much higher than that of the MPEG2 digital receiver. It's just that, in the 2000s, units of 

MPEG4 receivers were still quite limited and hard to find. 
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2013 can be said to be one of the years when the development of MPEG4 receivers 

was so fast. This is motivated because the MPEG4 receiver already supports a number of 

features, for example, being able to record television broadcasts, being able to open 

randomized broadcasts using Biss Key, cccam features, multimedia facilities, facilities for 

opening random Tanberg which is quite famous for the difficulty level in opening 

scrambles, facilities In addition, a number of MPEG4 receivers also have an Android-

based and Linux-based operating system embedded in it. 

 

3.3 Easy CAP  

According to Iyens Bsa (2017) EasyCAP is a connector tool that functions to connect 

Audio Video Out (RCA) from TV, Parabolic Receiver, DVD Player, Play Station, 

Camera/Handycam, CCTV. The important thing is the Audio-Video Out which will be 

connected to a USB computer or laptop or even an Android cellphone with the help of 

OTG (On The Go), so that it can be recorded and even edited. This tool is in the form of a 

USB connector that just plugs into a USB computer or laptop and Android cellphone. Very 

practical because the shape is very compact, so we can immediately record video and audio 

without the help of a soundcard or other hardware. 

 

 
Figure 1. Easy CAP 

 

3.4 Parabolic Antenna 

According to Aloha (2018), a parabolic antenna is an antenna that has high coverage 

and usually this parabolic antenna is used in radio, TV communication and also for 

radiolocation or (RADAR), in the UHF and SHF sections of the electromagnetic wave 

spectrum. The relatively short wavelengths of electromagnetic energy (radio) at these 

frequencies can make the size used for a parabolic antenna still within a reasonable size in 

terms of the high performance response desired to either receive or transmit a signal. The 

parabolic antenna that we know is shaped like a dish, well it can be seen in front of a house 

that uses a parabolic antenna, all of them are the same in the form of a round dish, some 

are small and large. 

 

Types of Parabolic Antennas  

There are several types / types of antennas on the market, including a very common 

type of dish antenna Solid, Net (Mess): 

 

a. Solid Parabolic Antenna (Dish Solid) 

The SOLID type parabolic antenna made of an alloy plate with alumenium as a 

reflector is actually divided into two, namely: 
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1. The dish is oval or offset focus with a small enough diameter between 45cm to 100cm. 

This is what we often encounter use for Pay TV such as Indivision, Transvision, K-

Vision, Orange TV, Astro, Aora, Big TV and many more (although some are not for 

pay tv such as Ninmedia and TV Desa Group). 

2. A round dish or prime focus which looks like most satellite dishes sold in the market. 

The sizes range from 4 to 12 feeds, but most of what is sold and used is only 6 feeds. 

 

b. Mesh Parabolic Antenna (Net) 

Mess type parabolic antenna is a net with small holes as its reflector. The sizes also 

vary, from 6 feeds, 7.5 feeds, 9 feeds, 12 feeds to 16 feeds, but what we often find and sell 

is 9 feeds and 12 feeds, although other sizes also use them. The dishes we often know and 

commonly know are the Paramount and Paragon brand antenna nets. 

The advantage of a net antenna is that it is not easy to rust because it is made of 

aluminum and is not heavy (light) compared to a solid prime focus antenna. 

 

3.5 Coaxial Cable 

Coaxial cable also known as BNC (Bayonet Naur Connector) or coaxial cable is 

often used for tv antenna cables and is often used on LAN networks. This cable is usually 

widely used to transmit high frequency signals from 300 kHz and above. Because of its 

ability to transmit high frequencies, the transmission system using coaxial cables has a 

fairly large channel capacity. 

 

 
Figure 2. Coaxial Cable 

 

According to Kuwat Kris (2017), a coaxial cable is a network cable wrapped in soft 

metal. Network installation using this cable is relatively easier than using a UTP cable, but 

the access speed on the cable is a little slower, so most people don't want to use it. Coaxial 

cables are more efficient to use for network systems with less capacity because of their 

access speed which does not allow them to be used on networks with large capacities. 

The parts of the coaxial cable: 

1. Conductor, this section is the core of the cable that functions as data traffic in the 

network 

2. Grounding is a filamentous cable twisted across and around an inner insulator. This part 

of the cable serves to anticipate the influence of unwanted electrical frequency 

interference. 

3. The inner insulator is part of the cable that serves to protect the conductor. 

The outer isolator is the part of the cable that is located on the outer shell which 

functions as a cable protector as a whole. 
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3.6 RCA Connector 

According to Isty (2017), the RCA cable is a cable that is usually used to send analog 

signals from audio or video equipment to other equipment. RCA cables tend to be large in 

size and each cable is separated by color because it has different uses. The yellow cable is 

usually used for visuals as a carrier for analog video signals, while the red and white cables 

are for audio, red cables are for the right channel analog audio signal and the white one is 

for the left audio channel. 

Called the RCA cable or Radio Corporation of America is one of the cables that has 

an important role to connect audio and video (visual) equipment. These cables are widely 

used in Indonesia and the ones that are often seen are usually connected from DVD to TV. 

However, there are also CCTV cables that apply this cable as a connection to cameras and 

DVRs. 

This RCA type connector is probably the one we see the most. This connector is 

commonly used in cables carrying audio and video (analog) signals. We can see it on a vcd 

or dvd player or video game when connected to the tv. 

 

 
Figure 3. RCA Connector 

 

3.7 Android 

Android is an Operating System (OS) or operating system which is very popular 

these days. It is undeniable that this operating system has taken a lot of attention from the 

world community and the Indonesian people, of course. Gadget and cell phone companies 

are competing to make devices using the Android operating system. Therefore, it is 

surprising that almost every day we see new gadgets on the market that use the operating 

system made by Google. 

 

a. Android Software Development Kit (SDK) 

Android is a software subset for mobile phones that includes the operating system, 

middleware and key applications released by Google. Currently, the Android SDK 

(Software Development Kit) is provided as a tool and API to start developing applications 

on the Android platform using the Java programming language.   

 

b. Android Version 1.1 

On March 9, 2009, the Google company released Android version 1.1. This version 

is equipped with an aesthetic update to the application, namely an alarm clock, voice 

search, sending messages with Gmail, and email notifications (Hermawan, 2010).  

 

c. Android Version 1.5 (Cupcake) 

Android Version 1.5 (Cupcake) There is an update in the operating system, including 

the addition of several features in this version, namely the ability to record and watch 

videos in camera mode, Bluetooth A2DP support, the ability to automatically connect to 
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on-screen animated Bluetooth headsets, and an on-screen keyboard that is can be 

customized and released in mid-May 2009 (Hermawan, 2010). 

 

d. Android Version 1.6 (Donut) 

Android version 1.6 (Donut) was released in September 2009 and differs from 

previous versions of Android which features a better search process, battery usage 

indicator and VPN applet control. Other features are galleries that allow users to have 

photos to be deleted, integrated cameras, camcorders and galleries, CDMA / EVDO, VPN, 

Gestures, and text-to-speech engines, dial contact capabilities, provision of WVGA 

resolution (Hermawan, 2010) . 

 

e. Android Version 2.0 / 2.1 (Éclair) 

Android version 2.0 / 2.1 (Eclair) launched in December 2009 has several changes, 

namely hardware optimization, changes to the User Interface (UI) with a new browser and 

HTML support, a new contact list, improved Google Maps 3.1.2, flash support for cameras 

3.2 MP, digital zoom, and Bluetooth 2.1 (Hermawan, 2010).  

 

f. Android Version 2.2 (Froyo) 

In May 2010, the Android phone version 2.2 (Froyo) was launched again, changes to 

version 2.2 include optimization of speed, memory and overall operating system 

performance, support for installing applications on external memory, support for Adope 

Flash 10.1 and USB Tethering and Wi-Fi functions. FI (Hermawan, 2010).  

 

g. Android Version 2.3 (GingerBread) 

December 1, 2010 Google re-launched the latest version, Android version 2.3. in this 

version there is an increase in power management, control through applications, the use of 

multiple cameras, increased performance and the addition of sensors such as a gyroscope 

(Hermawan, 2010). 

 

h. Android Version 3.0 / 3.1 (Honeycomb) 

This version is different from previous versions, this version is specifically designed 

for Tablet PCs so that it has a different User Interface (UI) and supports larger screen sizes. 

In addition, this version allows the use of multiple processors and hardware acceleration 

for graphics. The first version of the SDK was launched in February 2011, the next version 
that will appear, namely the Ice Cream version in the fourth quarter of 2011 (Hermawan, 2010). 

 

i. Android 4.0 (Ice Cream Sandwich) 

The peak of Android maturity is when in this version, which Ice Cream Sandwich 

was released in October 2011 ago. And this operating system starts working on any kind of 

smartphone. Apart from adding interesting features, Ice Cream Sandwich was also the 

Android version most liked at that time. In fact, Android Ice Cream Sandwich is also 

equipped with extra multitasking features and more notifications. 

 

j. Android 4.1.2 (Jelly Bean) 

Jelly Bean was released on July 9, 2012 through the Google I / O conference. This 

version is one of the versions of Android that often gets updates on useful and interesting 

features, some of which are improving screen rotation, such as Support for 4K video 

resolution, Support for writing Hebrew and Arabic letters from right to left, and improved 

performance, security systems and many others. 
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k. Android 4.4 (Kitkat) 

This version of Android is currently used by the majority of Indonesians. Kitkat is 

the version of Android which was released in 2013. in this version, Android gets a lot of 

feature updates. For example, there is a Screen recording feature, to record activities that 

occur on your smartphone screen, New Translucent system UI, improved notification 

access, System-wide settings for closed captioning, performance improvements and many 

others. 

 

l. Android 5.0 (Lollipop) 

Released in 2014, this Android offers more additional features to enhance existing 

features. And the Nexus 6 is one of the very first phones to taste this version of Android. In 

addition, Google is also further refining the performance of Android Lollipop itself. 

 

m.  Android 6.0 (Marshmallow) 

Android version 6.0 is one of the Android operating systems released in 2015, which 

brings many updates. One of them is USB Type-C support. Not only that, Android version 

6 also provides fingerprint authentication facilities and increased battery power. 

 

n. Android 7.0 (Nougat) 

Android Nougat version 7.0 was released in August 2016 which further improves the 

performance of the previous Android version. In addition, Android Nougat also gets many 

new features, including being able to multitask, improving the Doze feature that was 

released in previous versions of Android. 

And here are some of the newest features found in Nougat. 

1. Support Multi window 

2. Can directly reply to messages from the notification window or menu 

3. New notification panel and quick settings display 

4. Enhanced Doze mode (Doze Mode 2.0) 

5. Menu among system settings 

 

o. Android 8.0 (Oreo) 

The Android Oreo version was released in August 2017. Of course this Android 

version is the final version for now. Several features were also launched by Google as the 

manager. The features include: 

1. Android O focuses more on speed and efficiency 

2. 2X faster Boot up speed 

3. Picture in picture mode is more flexible than Android N 

4. Applications running in the background are more tightened to save battery 

5. Longer battery life 

6. Updated emojis and more 

 

p. Android Studio 

According to Davidk (2017) Android Studio is the official Integrated Development 

Environment (IDE) for Android application development, based on IntelliJ IDEA. Android 

is turning into a platform that is so fast in innovating. This is inseparable from the main 

development behind it, namely Google. Google was tired of acquiring Android and then 

building a platform. The android platform consists of a Linux-based Operating System, a 

GUI (Graphic User Interface), a web browser and downloadable End-User Applications 

and also the developers can freely work and create the best and open applications for use 
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by various devices. IDE (Integrated Development Environment) is a computer program 

that has several facilities needed in software development. 

An IDE, or freely translated as an Integrated Development Environment, has at least 

the following facilities: 

1. Editor is a facility to write the source code of the software. 

2. The compiler is a facility to check the syntax of the source code then convert it into 

binaries according to machine language. 

3. Linker is a facility to unify binary data from which some source code is generated by 

the compiler so that the binary data becomes one unit and becomes a computer program 

that is ready to be executed. 

4. Debuger, which is a facility to test the running of the program, to look for bugs or errors 

in the program. 

To some extent modern IDEs can help provide suggestions that speed up writing. 

When writing code, the IDE can also point out areas where it is clear that it contains errors 

or doubts. 

 

q. Project Structure 

Each project in Android Studio contains one or more modules with source code files 

and resource files. Module types include: 

1. Android application module 

2. Library Module 

3. Google App Engine Module  

All build files are visible at the top under Gradle Scripts and each app module 

contains the following folders: 

 

 
Figure 4. Project Files in the Android View 

 

1. manifests: Contains the AndroidManifest.xml file. 

2. java: Contains Java source code files, including JUnit test code. 

3. res: Contains all non-code resources, such as XML layouts, UI strings, and bitmap 

images. 

 

 

 



1144 

r. User Interface 

The Android Studio main window consists of several logical fields identified in the 

following figure: 

 
Figure 5. Android Studio Main Window 

 

1. Toolbars allow you to perform various types of actions, including running applications 

and launching Android tools. 

2. The navigation bar helps you navigate between projects and open files for editing. This 

bar provides a more compact view of the structure in the Project window. 

3. The editor window is where you create and modify code. Depending on the current file 

type, the editor may change. For example, when viewing a layout file, the editor 

displays the Layout Editor. 

4. The tool window bar appears outside the IDE window and contains buttons that let you 

expand or collapse individual tool windows. 

5. The tool window gives you access to specific tasks such as project management, 

tracing, version control, and more. You can expand as well as collapse. 

6. The status bar displays the status of your project and the IDE itself, as well as any 

warnings or messages. 

 

s. Tools Window 

Rather than using a preset perspective, Android Studio follows your context and 

automatically pops up relevant tool windows as you work. By default, the most frequently 

used tools are pinned to the tool window bar at the edge of the application window. 

1. To expand or collapse a tool window, click the tool name in the tool window bar. 

You can also drag, pin, attach, and drop the tool window. 

2. To return to the current default tool window layout, click Window> Restore 

Default Layout or adjust your default layout by clicking Window> Store Current 

Layout as Default. 

3. To show or hide the tool window bar, click the window icon in the lower-left 

corner of the Android Studio window. 

4. To find a specific tool window, hover over the window icon and select that tool 

window from the menu. 
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t. Gradle Build System 

Android Studio uses Gradle as the basis of the build system, with Android-specific 

capabilities provided by the Android Plugin for Gradle. This system can be run as an 

integrated tool from the Android Studio menu and independently from the command line. 

You can use the build system features to do the following: 

1. Customize, configure, and extend the build process. 

2. Create multiple APKs for your Android app, with different features using the same 

project and modules. Reuse code and resources across source sets. 

By applying Gradle's flexibility, you can achieve all of this without changing your 

app's core source files. The Android Studio version file is named build.gradle. This file is 

plain text that uses Groovy open in new to configure the version with elements provided by 

the Android plugin for Gradle. Each project has a top-level build file for the entire project 

and a separate module-level build file for each module. When you import the current 

project, Android Studio automatically generates the required version files. 

 

u. Profiling and Debug Tools 
Android Studio helps you debug and improve the performance of your code, 

including inline debugging and performance analysis tools. 

 

v. Inline Debug 

Use inline debugging to step up your code in the debugger view with inline 

verification of reference values, expressions, and variables. Inline debug information 

includes: 

1. Inline variable value 

2. Referring object that refers to the selected object 

3. The method's return value 

4. Lambda and operator expressions 

5. Tooltip value 

 

 
Figure 6. Inline Variable Value 

 

To enable inline debugging, in the Debug window, click Settings and select the 

checkbox for Show Values Inline. 

 

1) Performance Monitoring 

Android Studio provides performance monitoring so you can more easily track your 

app's memory and CPU usage, find unallocated objects, find memory leaks, optimize 

graphics performance, and analyze network requests. With the app running on the device 

or emulator, open the Android Monitor tool window and click the Monitors tab. 
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2) Heap Dump 

When you monitor memory usage in Android Studio, you can simultaneously initiate 

trash collection and dump the Java heap into a heap snapshot in an Android-specific 

HPROF binary format file. The HPROF viewer displays classes, instances of each class, 

and a reference tree to help you track memory usage and find memory leaks. 

 

3) Allocation Tracker 

Android Studio allows you to track memory allocation while monitoring memory 

usage. Track memory allocation allows you to monitor where objects are allocated when 

you perform certain actions. Knowing this allocation allows you to optimize application 

performance and memory usage by adjusting the calling method associated with the action. 

 

4) Access Data Files 

The Android SDK tools, such as Systrace, logcat, and Traceview, generate 

debugging and performance data for detailed app analysis. To see the availability of the 

resulting power file, open the Captures tool window. In the list of generated files, double-

click the file to view the data. Right-click the .hprof file to convert it to the standard hprof 

file format. 

 

5) Code Check 
Whenever you compile your program, Android Studio will automatically run 

configured Lint and the IDE Check for open in new helps you easily identify and fix 

problems with the structural quality of your code. The Lint tool checks your Android 

project source files for possible bugs and optimization fixes for accuracy, security, 

performance, usability, accessibility and internationalization. 

 

 
Figure 7. Results of a Lint Check in Android Studio 

 

6) Annotations in Android Studio 
Android Studio supports annotations for variables, parameters, and return values to 

help you catch bugs, such as null pointer exceptions and resource type conflicts. The 

Android SDK Manager packages libraries in the Android Support Repository for use with 

Android Studio. Android Studio will validate configured annotations during code 

inspection. 

 

7) Log messages 

When building and running your app with Android Studio, you can view device logs 

and output messages and adb (logcat) by clicking Android Monitor at the bottom of the 

window. If you want to debug your app with Android Device Monitor, you can open 
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Device Monitoring by clicking Tools> Android> Android Device Monitor. In Device 

Monitor you can find a complete set of DDMS tools for identifying applications, 

controlling device behavior, and so on. Also included is the Hierarchy Viewer tool to help 

optimize your layout. 

 

8) Android Debug Bridge (ADB) 
Serves as a versatile command tool allowing you to communicate with an emulator 

instance or a connected Android device. This facilitates a variety of device actions, such as 

installing and debugging applications, and provides Unix shell access that you can use to 

run various commands on the emulator or connected device. It is a client-server program 

that includes three components: 

1. Client, who sends orders. The client runs on your development machine. You can 

request clients from the command-line terminal by issuing the adb command. 

2. Daemons, which execute commands on the device. The daemon runs as a background 

process on each emulator or device instance. 

3. The server, which manages the communication between the client and the daemon. The 

server runs as a background process on your development machine. 

 

9) Enable ADB Debugging on Your Device 

To use ADB with a device connected via USB, you must enable USB debugging in 

the device system settings, under Developer options. 

On Android 4.2 and up, the Developer options screen is hidden by default. To make 

it visible, go to Settings> About phone and tap Build number seven times. Return to the 

previous screen to find Developer options at the bottom. On some devices, the Developer 

options screen name or location may be different. 

You can now connect your device via USB. You can verify that your device is 

connected by running adb devices from the android_sdk / platform-tools / directory. If 

connected, you'll see the device name listed as "device". 

 

3.8 Java 

Java is a high-level, object-oriented programming language and a Java program is 

composed of parts called classes. Classes consist of methods that do work and return 

information after doing their job. Java programmers take advantage of the collection of 

classes in the Java class library, which is called the Java Application Programming 

Interface (API). These classes are organized into groups called packages. The Java API has 

provided sufficient functionality for creating sophisticated applets and applications. So 

there are two things that must be learned in Java, namely learning the Java language and 

how to use classes in the Java API. Class is the only way of declaring the executable part 

of the program, there is no other way. In Java the javac program is used to compile Java 

source code files into bytecode classes. The source code file has the extension * .java. The 

javac compiler generates class bytecode files with the extension * .class. The interpreter is 

the main module of the Java system that is used by Java applications and runs Java 

bytecode programs. 

 

Java Code Structure in Android Studio  

Following are some lines of java code in Android Studio that are automatically 

generated when you create an activity. 
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Figure 8. Java Code Structure in Android Studio 

 

3.9 Github  

According to Candra Adi Putra (2014) Github is a hosting software for open source 

projects that uses the Git control revision Tool System. So Git is a tool for revising code, 

while github is the web hosting. Easily Github is Webhosting for software projects such as 

Google code or sourceforge net. Github is a popular shared web service for software 

development projects that use a Git version controller system or a hosting service for open 

source projects that use the Git control revision Tool System. In simple terms, Github is a 

social network for developers in developing a project. This github site provides social 

networking functionality and social networking graphics to show how the developers are 

working on their repository version. 

Github also operates other services: a pastebin-style site called Gist which provides a 

wiki for each repository and an editable web page via a Git repository, a slide hosting 

service called Speaker Deck, and a web analysis platform called Gauges. As of January 

2010, Github is operated under the name Github, Inc. The software that runs Github is 

written in Ruby on Rails and Erlang by the Github developers. 

 

3.10 Satellite Tracking  

According to Najwa (2016) Satellite tracking is positioning the dish or parabolic dish 

towards the satellite that was shot to get the satellite signal. To get the maximum signal 

from the target satellite, this dish must be pointing exactly right at the satellite. slightly off 

the mark, so the results are not optimal. might not even get the signal at all. In general, a 

tool for tracking satellites is called a satellite finder. This tool will help the tracker (the 

person who is tracking) if the dish that is being tracked leads to a target satellite. after the 

dish leads to the satellite, we just need to maximize the signal. here is a very important 

point. The angle of declenation, elevation and azimuth must be precise to maximize the 

signal received. 

 

Flow Chart 

Flowchart is a chart with certain symbols that describe the sequence of processes in 

detail and the relationship between a process ith another process in a program. 
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Table 1. Flowchart 

 
 

 

IV. Conclusion 
 

 Based on the results of the design and implementation that has been done, and based 

on the formulation of the existing problems, several conclusions can be drawn including 

the following: 

1. Making a Low Noise Block Converter application for android smartphones can be made 

with Android Studio using the java language. 

2. Low Noise Block Converter application as an application to facilitate tracking satellites 

and can run well on android OS version 7.0 nougat. 

3. With this application as a new alternative in tracking satellite. 

4. Android smartphones can be used optimally by using the Low Noise Block Converter 

application for satellite tracking. 
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